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1. Background: 

 

Subscribers registered with CRA are allowed to update the existing details in the available CRA 

system. For the purpose of carrying out these changes, Subscriber has to submit a Subscriber 

Detail Change Request form (S2 form) to the concerned PAO/DTO. The said form is available at 

CRA website wherein the subscriber can download the S2 form. 

 

Link for site is  : https://npscra.nsdl.co.in/  

 

The subscriber is required to go through below mentioned option 

 

Home --→Central Government/State Government--→ Forms--→ NPS Account Maintenance--→Form S2: 
Subscriber Details Change 
 

 

 
 

 

Nodal office can update below mentioned details of subscriber in the CRA system by through login 

its User IDs. 

• Email ID and Mobile number 

• Address details  

• Nomination details 

• Bank Details 

 

Flow Matrix for Processing Change Request 

(Email ID/Mobile Number/ Address Details /Nomination and Bank Details) 

Request Initiation Authorization 

PAO/DTO (User 1) PAO/DTO (User 2) 

 

 

 

 

 

 

 

 

https://npscra.nsdl.co.in/
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The subscribers can submit the documents for change request to concerned DDO office. Based 

on the availability of option, DDO office may initiate the subscriber details change request in CRA 

log in and forward to DTO/PAO office for further verification/authorization. If DDO has no access 

for processing any modification, the office needs to send the request the concern DTO/PAO.  

 

It is the responsibility of the office to check veracity of documents as provided by the subscriber 

before processing any modification in the system. 

 

 

Updation of core details in PRAN 

 

For updation in core details i.e. Name/DoB/ DoJ and DoR, the same can be updated by Nodal office 

only through its login. For the same, a separate SOP is available namely “SOP for updating 

Subscriber details_V_1.2”. The offices are requested to refer the same for updation of core details. 

 

 

  

https://npscra.nsdl.co.in/download/government-sector/central-government/Standard-Operarting-Procedures-for-Nodal-Offices/nodal-offices/12.%20SOP_Subscriber_Details_Update_%20Version%201.2.pdf
https://npscra.nsdl.co.in/download/government-sector/central-government/Standard-Operarting-Procedures-for-Nodal-Offices/nodal-offices/12.%20SOP_Subscriber_Details_Update_%20Version%201.2.pdf


 
 

Classification: Public Version No : 1.3 16-09-2025 Page: 6 of 41 

 

 

2. Subscriber based Journey: 

 

Subscribers registered under NPS also have an option to initiate the request for updation of their 

personal details such as address, mobile number, email ID, bank account and nominee details in 

CRA System using the I-PIN provided to them by CRA. Alternatively, the subscriber can provide the 

request to nodal office and nodal office would initiate the request on behalf of its subscribers 

based on documents received. 

 

The steps for modification of these details thorough subscriber end are mentioned below. 

 

(Please note for updation of address/contact details/ mobile, these details can get updated 

through self authorisation based on OTP/e-sign and in case of bank /nominee details, the 

modification request is required to be verified and authorised by nodal office as mentioned in 

SOP). 

 

➢ Steps for updation of contact/email details of subscriber 
o Login into CRA using user id & password 
o Under Manage my Account, Click on Update my Profile 
o Click on Change contact details 
o Subscriber can update : Email id or Mobile no 
o Click in Email id/Mobile no, enter the new details  
o Click on Submit button, Click on Proceed button 
o OTP will be sent to New Mail id/Mobile no. 
o After entering the OTP, the details will be updated 
 

In case, if newly updated email id or mobile no is already exist in CRA system, error will be shown 

to the subscriber about duplicity. 

 

➢ Steps for updation of address details of subscriber 

o Login into CRA using user id & password 

o Under Manage my Account, Click on Update my Profile and click on Change Address 

o Subscriber can update the address through Aadhaar number or PAN no. (in case of PAN 

no, CKYC details should be updated) 

o Enter the Aadhaar Number & click continue.  

o OTP will be sent to registered Mobile no. once the OTP is entered Old & new address will 

be show to subscriber 

o Click on generate OTP, enter the OTP. 

 

➢ Steps for updation of Nominee details of subscriber 

o Login into CRA using user id & password 

o Under Manage my Account, Click on Update my Profile, Click on update nomination 

o Click on update nominee details. 

o Update the nominee details, click on submit. 

o On submission, OTP will be sent to registered mobile no. on submission of OTP ack id will 

generated & same need to be verify/ authorize by nodal office. 
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➢ Steps for updation of Bank details of subscriber 

o Login into CRA using user id & password 

o Under Manage my Account, Click on Update my Profile,  

o Click on update Bank details -  Tier 1 / Tier 2 

o Select Type of Transaction - Modify Bank Details  

o The existing bank details will be shown to the subscriber. Also, the subscriber is requested 

to enter new bank details. 

o The Govt. subscriber need to tick on the following declaration 

“I hereby declare that my NPS Bank account is my salary bank account and atleast one salary 
has been credited” 

o The subscriber is required to do penny drop for updated bank account. 

o On successful penny drop, Ack id will get generated and the same need to be verify/ 

authorize by nodal office. 
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3. Process to Update Subscriber i.e. Email ID/Mobile Number/Address Details  

 

3.1 Request initiation by PAO/DTO office Nodal Office User 1 (Maker)  

1. Log in to https://npscan-cra.com/CRA/. Enter PAO/DTO office user Id and password. Click 

on “Submit” (Refer figure 1) 
Figure 1 

 
 

2. Click on menu “Transaction”→ “Update Subscriber Details” (Refer figure 2) 
Figure 2 

 
 

 

https://npscan-cra.com/CRA/
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3. Enter PRAN of subscriber under “Subscriber Details View” option. Click on “Submit” 

(Refer figure 3) 
 

Figure 3 

 

 

4. Click of “Edit” option to enter New details. (Refer figure 4) 
 

Figure 4 
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5. To check the existing personal details please click on Personal Details tab. (Refer figure 5) 
 

Figure 5 

 

 

6. Existing personal details can be viewed under Personal Details tab (Refer figure 6) 
 

Figure 6 
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7. Please enter new detail in respective field and click on “Submit”. In case mobile number/email 

ID details already exists in CRA records, system will prompt an error “Duplicate Mobile Number 

Already Exists in CRA system.” The office needs to check with the subscriber for the said duplicity 

and request for another mobile number for updation if available.  (Refer figure 7 & 8 ) 
 

Figure 7 

 

 

Figure 8 

 

 

8. Nodal office is required to Upload supporting Proof i.e. S2 Form signed by subscriber along 

with supporting documents. (Refer figure 9 & 10 ) 
• Uploaded Attachment/Allowed file types: pdf/xls/png/doc/xlsx/jpeg/docx/zip/jpg. 

• Maximum File Size Limit: 5MB.  

• Only 1 document can be uploaded. 

• File Name should not have special characters or space. 

 

It is the responsibility of the office to check veracity of documents as provided by the 

subscriber. 
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Figure 9 

 
 
Figure 10 
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9. Updated details entered in CRA system will be highlighted in red color text. Office may verify 

the details and click on “Submit” option. (Refer figure 11) 
 
Figure 11 

 
 

 

10. Message will be displayed on screen once subscriber details change request are captured 

successfully. 

Acknowledgment number will be displayed on screen. (Refer figure 12) 
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Figure 12 

 
 

11. Status of request can be checked under option: View--→ Request Status -View→ Transaction 

Type→ Enter PRAN/ Acknowledgment number (Refer figure 13 ,14 & 15) 
 
Figure 13 

 
 
Figure 14 
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Figure 15 
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3.2 Request Authorization by PAO office Nodal Office User 2 (Checker/Authorizer) 

 

12. Log in to https://npscan-cra.com/CRA/ and enter PAO/DTO user Id and password. Click on 

“Submit” (Refer figure 16) 
 
Figure 16 

 
 

13. Click on menu “Transaction”→ “Authorize Transaction” (Refer figure 17) 
 
Figure 17 

 
  

https://npscan-cra.com/CRA/
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14. Enter “Transaction Type” and PRAN. Click on “Search” (Refer figure 18) 
 
Figure 18 

 
 

15. Click on Hyperlink “View Details” to check the new details entered by maker user. (Refer figure 
19)  
 
Figure 19 
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16. Click on personal details tab to check new updated details. Updated details are highlighted in 

Red Color Text. (Refer figure 20) 
 
Figure 20 

 
 

 
 

17. Office may Authorize/Reject the request after checking supporting documents are details 

updated by maker user. (Refer figure 21) 
 

It is the responsibility of the office to check veracity of documents as provided by the 

subscriber. 

 
Figure 21 
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18. Message will be displayed on screen once subscriber details change request is authorized 

successfully. (Refer figure 22) 
 
Figure 22 
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4. Process to Update Subscriber Bank Details-: 

 

4.1 Request initiation by PAO/DTO office Nodal Office User 1 (Maker) 

 

1. Log in to https://cra-nsdl.com Enter PAO office user Id and password. Click on “Submit” 

(Refer figure 23) 
 
Figure 23 

 
 

2. Click on option “Transaction”-→ ”Subscriber Bank Details Update” (Refer figure 24) 
 
Figure 24 

 

https://cra-nsdl.com/
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3. Click on option Transaction→“Update Bank Details”-→ ”Submit” (Refer figure 25) 
 
Figure 25 

 
 

4. Existing bank details registered in CRA can be viewed. (Refer figure 26) 
 
Figure 26 
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5.  Enter New bank details. Click on declaration and “Penny Drop” option.  (Refer figure 27 & 28) 
 

It is the responsibility of the office to check veracity of documents as provided by the 

subscriber. Further, the office needs to ensure that the bank details to be updated are 

salary bank account only for Govt. subscribers. 

 

In case bank detail entered by nodal office already exists in CRA system will prompt an error 

“Duplicate Bank Account Number exists in CRA System. Please try Different combination of Bank 

Account number and Bank IFSC Code” 

 
Figure 27 
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Figure 28 

 
 

 

6. On successful “Penny Drop” verification through bank, below message will appear. (Refer figure 
29) 
 
Figure 29 

 
 

In case of penny drop request failure below error message will appear. (Refer figure 30) 
 
Figure 30 

 
 



 
 

Classification: Public Version No : 1.3 16-09-2025 Page: 24 of 41 

 

 

7. Please upload scan copy of S2 form duly filled and signed by subscriber and supporting bank 

detail proof in system. Click on Submit option. (Refer figure 31) 
 

(Only 'jpeg', 'jpg', 'png' & 'pdf' formats are allowed for document upload with maximum size of 2 

MB)  

 

 
Figure 31 

 
 

8. Verify new updated details and click on “Confirm” (Refer figure 32) 
 
Figure 32 
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9. On successful initiation of request, the subscriber will be received SMS on registered mobile 

number and email ID. (Refer figure 33) 
 
Figure 33 

 
 

10. To check the status of request, click on option Transaction→“View Request Status”→ Submit. 

(Refer figure 34) 
 
Figure 34 

 
Please note the office is required to click on the declaration confirming that the given bank 

account is salary bank account of the employee as per office record. 
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4.2 Request Authorization by PAO/DTO office Nodal Office User 2 (Checker/Authorizer) 

 

11. Nodal office will log in to CRA (https://cra-nsdl.com) with user ID 2 (Checker/Authorizer) (Refer 

figure 35) 
Figure 35 

 
 

12. Click on option Transaction-→ “Subscriber Bank Details Update”→ Authorize Bank Details 

(Refer figure 36) 
 
Figure 36 

 

https://cra-nsdl.com/
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13. Enter PRAN/Acknowledgement details→ Submit (Refer figure 37) 
 
Figure 37 

 
 

14. Click on Hyperlink “Acknowledgement Number” to check and verify the details. (Refer figure 
38) 
 
Figure 38 
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15. Details of pending request will be visible along with status. Click on Hyperlink “Click Here to 

Check Bank Details” (Refer figure 39) 
 
Figure 39 

 
 

16. Office can view and download the supporting documents uploaded while initiating maker 

request. 

To authorize/reject the request close existing preview. (Refer figure 40) 
 

It is the responsibility of the office to check veracity of documents as provided by the 

subscriber. 
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Figure 40 

 
 

17. To approve /reject the request, select click on hyperlink under tab “Action” (Refer figure 41) 
 
Figure 41 

 
 

18. Remarks can be entered while authorization of request if any. Click on “Approve” (Refer figure 
42 & 43) 
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Figure 42 

 
 
Figure 43 
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19. On successful authorization below message will be displayed on screen. (Refer figure 44) 
 
Figure 44 

 
 

20. To check the status of request, click on option Transaction→“View Request Status”→ Submit. 
(Refer figure 45) 
 
Figure 45 
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5. Process to Update Subscriber Nomination Details  

 

5.1 Request initiation by PAO office Nodal Office User 1 

 

1. Log in to https://cra-nsdl.com Enter PAO office User ID and password. Click on “Submit” 
(Refer figure 46) 

 
Figure 46 

 
 

 

2.  Click on option “Transaction”-→ ”Subscriber Nominee Details Update” (Refer figure 47) 
 
Figure 47 

 
  

https://cra-nsdl.com/
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3. Click on option “Update Nominee Details”, enter PRAN of subscriber and click on “Submit” 

(Refer figure 48) 
 

Figure 48 

 

 

4. Select Tier Type (I/II) for which nominee details are required be updated and click on “Submit” 

(Refer figure 49) 
 

Figure 49 
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5. To check the existing nomination details please click on Nomination Details tab. (Refer figure 
50) 
 

Figure 50 

 

 

6. Under Section “Nomination Details”, nodal office can Remove existing details and Add new 

nominee details. (Refer figure 51) 
➢ Maximum up to 3 nominees can be entered. 

➢ Percentage Share for all nominees should not exceed more that 100%. 

➢ In case nominee is “Minor” Guardian details are mandatory. 

 

It is the responsibility of the office to check veracity of documents as provided by the 

subscriber. 

 
Figure 51 
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7. Nodal office is required to Upload supporting Proof i.e. S2 Form signed by subscriber along 

with supporting documents. (Refer figure 52) 
• Uploaded Attachment/Allowed file types: pdf/xls/png/doc/xlsx/jpeg/docx/zip/jpg. 

• Maximum File Size Limit: 5MB.  

• Only 1 document can be uploaded. 

• File Name should not have special characters or space. 
Figure 52 

 

 
 

8. Updated details entered in CRA system will be highlighted in Red Color text.  

Office may verify the details and click on “Submit” option. (Refer figure 53) 
Figure 53 
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9. Message will be displayed on screen once subscriber details change request are captured 

successfully. 

Acknowledgment number will be displayed on screen. (Refer figure 54) 
 

Figure 54 

 
 

10. Status of request can be checked under option: 

 

View--→ Request Status -View→ Transaction Type→ Enter PRAN/ Acknowledgment number        

(Refer figure 55) 
Figure 55 
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5.2 Request Authorization by PAO/DTO office Nodal Office User 2 (Checker/Authorizer)  

 

11. Nodal office will log in to CRA (https://cra-nsdl.com) with user ID 2 (Checker/Authorizer)              

(Refer figure 56) 
Figure 56 

 
 

 

12. Click on option “Transaction” → ”Subscriber Nominee Details Update” (Refer figure 57) 
 
Figure 57 

 
 

  

https://cra-nsdl.com/
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13. Click on “Verify/Authorize Nominee Details” to view the details of pending requests. The 

checker can enter either Ack id/ PRAN or provide date range to check the pending requests.  

 

Click on hyperlink Acknowledgement Number.  (Refer Figure 58) 
 
Figure 58 

 
 

14. New updated Details are highlighted in Red Color text. (Refer figure 59) 
 
Figure 59 
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14. The checker may Accept/Reject the request after verifying the details entered by the maker 

and also the supporting documents as uploaded. (Refer figure 60). In case of rejection, the 

checker needs to mention the reason for rejection. 
 
Figure 60 

 
It is the responsibility of the office to check veracity of documents as provided by the 

subscriber 

 

15. Message will be displayed on screen once subscriber details change request are 

authorized/rejected. (Refer figure 61) 
 

Figure 61 
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16. Status of request can be checked under option “Subscriber Nominee Details Update”→ View 

Request Status. (Refer figure 62) 
Figure 62 

 
 

     ****************** 


